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Introduction 
The Plus-X Dual IP-8 Adapter connects directly to existing ARC-16 IP-8 Interface Panels to allow a fast, 

easy upgrade from the ARC-16 to the ARC Plus Remote Control. The Plus-X Dual IP-8 Adapter 

communicates with the ARC Plus via LAN/WAN, allowing installation anywhere a network connection is 

available. 

The Plus-X Dual IP-8 Adapter is part of the Plus-X family of Ethernet I/O products designed for the ARC 

Plus. 

Installation Note 

Even though you may operate the ARC Plus and Plus-X Dual IP-8 Adapter on different subnets, Burk 

Technology strongly recommends installing the Plus-X Dual IP-8 Adapter on the same LAN as the ARC 

Plus. In a network failure, an ARC Plus can only continue to monitor and control a Plus-X device on the 

same LAN. If the network link between the units is not available, ARC Plus macros, alarm monitoring 

and telephone control will be unavailable for the Plus-X device. 

Before you Begin 

Before installing the Plus-X Dual IP-8 Adapter, please have the following network settings ready: 

 A static IP address for the Plus-X Dual IP-8 Adapter 

 The IP address of your ARC Plus 

 The subnet mask and gateway address for your LAN 

If you will be importing your ARC-16 settings, be sure to save your settings in AutoLoad 2 for the ARC-

16 (this will create a .a16 file). If you will be manually configuring your channels, make careful note of 

the following for each channel: 

 Meter label 

 Calibration type 

 Decimal places 

 High limit 

 Low limit 

 Alarm delays (meter and status) 

 ESI meter label 

 ESI meter units label 

 ESI status message 

 Status inversion setting 

 Status alarm setting 

 Command duration 
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Compatibility 
Before installing the Plus-X Dual IP-8 Adapter, please verify that the ARC Plus firmware, AutoPilot 

software and AutoLoad Plus software versions are current. Updates are available at www.burk.com. 

The following are minimum software and firmware requirements 

Software  Version 

ARC Plus firmware 2.1.0 or higher 
AutoLoad Plus software* 2.0.0 or higher 
AutoPilot® software 2.5.0 or higher 

 
 

* If using any version of AutoLoad Plus earlier than 2.3.0, you will need to download the Plus-X Dual IP-8 

Adapter AutoLoad definition XML file from www.burk.com. 

Unpacking 
The Plus-X Dual IP-8 Adapter ships with the following: 

 Plus-X Dual IP-8 Adapter unit 

 Power cord 

 10’ shielded CAT5 cable 
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Front Panel Indicators 
 

 

Front panel of the Plus-X Dual IP-8 Adapter 

Indicator State Description 

Power LED Off Power is off 

Power LED Green Power is on 

Power LED Amber No firmware loaded (contact Customer 
Support) 

Power LED Flashing 
Green 

Resetting to factory default settings 

Link LED Green Connected to ARC Plus 

Link LED Off No connection to ARC Plus 

Link LED Flashing 
Green, Red 

Maintenance Mode 

Link LED Flashing Red No connection to ARC Plus, unit is in 
maintenance mode 

Hardware Configuration 
The Plus-X Dual IP-8 Adapter is configured via its onboard web interface. Open a web browser and 

navigate to 192.168.0.100. The web page will prompt you for a username and password. Enter the 

username admin and password password. (The network interface on your PC must be set to operate 

on IP network 192.168.0.xxx  to make this connection.) 

Note: The default IP address is 192.168.0.100 and the default password is “password”. If either of these 

values have been changed and you do not know what they are, you need to perform a master initialization. 

Press and hold the MASTER INIT button on the rear panel for three seconds. This will reset the Plus-X Dual 

IP-8 Adapter to its factory default settings. 

Settings 

Click the Settings link on the web page header to access the Plus-X Dual IP-8 Adapter settings. Fill out 

the following fields: 

 IP Address 

 Subnet Mask 

 Gateway 

 ARC Plus IP Address 
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You may optionally change the HTTP and Plus-X ports of the Plus-X Dual IP-8 Adapter. The default 

settings are recommended. 

Burk Technology recommends changing the Plus-X Dual IP-8 Adapter password. The password is used 

to log on to the onboard web interface. To change the password, check the Change Password box and 

enter the new password in the Password and Confirm fields. 

When you are finished, click Save. 

If you changed the Plus-X IP address to a network other than 192.168.0.xxx, it will be necessary to 

change the settings of the network interface on your PC to operate on that same network. 

Note: If you are unsure what network settings to use, contact your network administrator. 

 

Plus-X Dual IP-8 Adapter Settings 

Installation 
After entering the configuration settings, you are ready to install the Plus-X Dual IP-8 Adapter in its 

permanent location. Simply move the IP-8 cables from the ARC-16 to the Plus-X Dual IP-8 Adapter. 

Connect the Plus-X Dual IP-8 Adapter to the LAN/WAN, if it is not connected already.  
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Software Configuration 
Now that the Plus-X Dual IP-8 Adapter is installed on the network, you are ready to add the unit to the 

ARC Plus using AutoLoad Plus. AutoLoad Plus is included with the ARC Plus, and may also be 

downloaded from www.burk.com. 

Configuration involves: 

 Adding the Plus-X Dual IP-8 Adapter unit to the ARC Plus 

 Mapping Plus-X Dual IP-8 Adapter channels to unused ARC Plus channels 

 Importing settings from your ARC-16 (optional) 

Adding the Plus-X Dual IP-8 Adapter to the ARC Plus 

 

 

Adding a Plus-X device in AutoLoad Plus 

In order for the ARC Plus to recognize the Plus-X Dual IP-8 Adapter, the Plus-X Dual IP-8 Adapter must 

be added to the site: 

1. Open AutoLoad Plus and connect to the ARC Plus site to which you are adding the Plus-X Dual 

IP-8 Adapter. 

2. From the Edit menu, select Plus-X Devices to open the Plus-X device configuration dialog. 

3. Click Add to add the Plus-X Dual IP-8 Adapter to the site. 

4. AutoLoad Plus will prompt you to select the device type. Select Plus-X Dual IP-8 Adapter. You 

may optionally change the description for the Plus-X device. The description appears in 

AutoLoad Plus to identify each Plus-X device. 

5. Enter the IP address and port number of the Plus-X Dual IP-8 Adapter. These should be the 

same settings you used when you configured the Plus-X Dual IP-8 Adapter via the web. 
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6. Check the Map default set of channels box if you wish to automatically add the Plus-X Dual IP-

8 Adapter channels to the ARC Plus (recommended). The ARC Plus must have 16 consecutive 

unused channels, including the starting channel.  

7. Click OK. 

Note: The above instructions are for AutoLoad version 2.3 or above. Earlier versions vary slightly in 

appearance and labeling only. 

Manually Mapping Plus-X Dual IP-8 Adapter Channels 

 

 

Overriding channels in AutoLoad Plus 

If desired, you may manually map Plus-X Dual IP-8 Adapter channels to ARC Plus channels  in AutoLoad 

Plus by selecting the Meter Channels, Status Channels or Commands tab, as appropriate: 

1. Within any of these tabs, click the […] button in the Source column to configure a channel to 

use a Plus-X device channel as its source. 

2. When the Source dialog appears, select Plus-X channel and choose the Plus-X device from the 

list.  

3. Select the Plus-X Dual IP-8 Adapter channel you wish to use. 

4. Click OK. 

Once mapped, each Plus-X Dual IP-8 Adapter channel will appear on the front panel of the ARC Plus, in 

AutoPilot, on the ARC Plus web page, and will be accessible via the RSI. 
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Importing ARC-16 Settings 
AutoLoad Plus version 2.3 or later can import your ARC-16 settings using the .a16 file created by 

AutoLoad 2 for the ARC-16. To import your settings, choose Import ARC-16… from the File menu in 

AutoLoad Plus. 

The wizard will prompt you for your ARC-16 settings file, and then allow you to choose which settings 

to import. For each setting, use the Import checkbox to indicate that AutoLoad should import that 

setting. Follow the onscreen instructions to complete the wizard. For more information, consult the 

AutoLoad Plus Manual or help file. 

Uploading New Firmware 
You can load new firmware to the Plus-X Dual IP-8 Adapter using its onboard web interface. Navigate 

to the IP address of the Plus-X Dual IP-8 Adapter, log on and click the Upload Firmware link. Click the 

Browse button to select the firmware file, then click Upload to load the new firmware. The Plus-X Dual 

IP-8 Adapter will reboot after the firmware upload is complete. 

 

Uploading Firmware to the Plus-X Dual IP-8 Adapter 

For the latest firmware updates, visit www.burk.com. 
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Troubleshooting 
If the network connection between the Plus-X Dual IP-8 Adapter and ARC Plus is lost, the ARC Plus will 

log an alarm after three minutes of network failure. The Plus-X Dual IP-8 Adapter Link LED will also turn 

off. Check your network settings on both the ARC Plus and Plus-X Dual IP-8 Adapter. 

Note: Plus-X Dual IP-8 Adapter events and errors are logged to the ARC Plus event list, which is accessible 

by the ARC Plus front panel and from AutoPilot. 

If the Plus-X Dual IP-8 Adapter channels show as “offline” in the ARC Plus web interface, check the 

following: 

 The network settings were configured correctly as described in Settings.  

 The Plus-X settings were correctly entered in AutoLoad Plus as described in Adding the Plus-X 

Dual IP-8 Adapter to the ARC Plus. 

 The changes entered in AutoLoad Plus were saved to the ARC Plus by clicking the save  

button:   or by selecting File>Save in the AutoLoad Plus menu. 

Getting Help 
For customer support, please email support@burk.com or call our direct customer support line at 978-

486-3711. We will be glad to assist you. The customer support office is open Monday – Friday, 9AM to 

5PM Eastern time. 

Warranty 
Burk Technology, Inc. warrants the Plus-X Dual IP-8 Adapter to be free of defects in materials and 

workmanship for a period of 24 months from the date of purchase. Equipment will be repaired or 

replaced at the option of Burk Technology and returned freight prepaid to the customer. Damage due 

to abuse or improper operation or installation of the equipment or caused by fire or flood or harsh 

environment is not to be covered by this warranty. Damage in shipping is not the responsibility of Burk 

Technology. A return authorization must be obtained before returning any equipment. Materials 

returned under this warranty must be shipped freight prepaid and insured in the original shipping 

carton or suitable substitute to Burk Technology, Inc., 7 Beaver Brook Road, Littleton, MA 01460. 

Repairs not covered under this warranty will be made at prevailing shop rates established by Burk 

Technology. 

THE WARRANTY SET FORTH ABOVE IS IN LIEU OF ALL OTHER WARRANTIES, EXPRESS OR 

IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY AND 

FITNESS FOR A PARTICULAR PURPOSE. BURK TECHNOLOGY, INC. SHALL NOT BE LIABLE TO ANY 

PARTY FOR ANY INCIDENTAL, SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES ARISING FROM 

THEUSE OF THIS EQUIPMENT. 
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Appendix A: Specifications 
 

Dimensions: 

1.75” (4.45cm) H 
19” (48.26cm) W 
12” (30.48cm) D 
 

Operating Temperature: 

0o to 40oC 
 

Power Requirements: 
100 to 240VAC, 47-63Hz, 1A; power entry module with standard, grounded power cord supplied; 1A 
fuse protection 
 

Connectivity: 

Ethernet connection to ARC Plus; DB37 cables to IP-8 (not included) 
 

Channel Capacity: 

8 metering, 8 status and 8 command channels per IP-8 (up to 2 IP-8s) 
Existing IP-8(s) required 
 

Metering Input Range: 

-4.5VDC to +4.5VDC 
 

Metering Input Accuracy: 

>99.75% accuracy, full scale 
 

Status Input Range: 
>0 to +28VDC or switch closure 
 

Output Types: 

32 Open collector outputs (16 raise, 16 lower); maximum 250mA, 28V 
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